Interactive Physics
THE WORLDWIDE STANDARD IN PHYSICS SIMULATION SOFTWARE

BOOST YOUR PHYSICS CURRICULUM WITH POWERFUL
MOTION SIMULATION TECHNOLOGY
The foundations of scientific discovery are imagination and
inquisitive “what if” curiosity. Interactive Physics makes your
students active learners and empowers them to:
•
•
•
•

Explore their physical world through fast-paced exciting
simulation
Visualize the abstract scientific concepts taught in the
classroom
Test hypotheses and investigate “what if” scenarios
Learn school-to-career job skills with real-world motion tools

Adopted by more than 18,000 schools worldwide, try Interactive
Physics and see why it has been named the “Best Educational
Software Product” several years running.

EASY AND FUN TO USE! WATCH PHYSICS IN ACTION!
Create new experiments or interact with pre-designed Physics
exercises to:
•
•
•
•
•
•

Measure velocity, acceleration, force, momentum, energy,
etc., in metric or English units
Create ropes, springs, dampers, pulleys, slot joints, linear
actuators, and rotational motors
Hear and measure sound volumes, sound frequencies,
and Doppler effects
Vary air resistance, gravity, or material properties
Create visually appealing presentations by attaching
graphics to objects
View results as numbers, graphs, and animated vectors

Encourage hands-on, minds-on, and can-do attitude in the classroom.
www.interactivephysics.com

www.interactivephysics.com
EASY CURRICULUM
INTEGRATION

COMPLETE CURRICULUM
SUPPORT

Interactive Physics allows
students to master concepts
in a safe environment, without
costly lab supplies and timeconsuming lab setup. Your
physics lectures and lab activities will immediately benefit
from Interactive Physics!

•

•

•
Select from a wide range
of ready-to run exercises
built for your curriculum

•

Rapidly customize existing models to meet your
specific needs

•

Create and share models
with teachers and students

•

Compare simulation data
with theoretical results

•

•

•

Demonstrate hard-toexplain concepts like
Coriolis acceleration
Show properties of objects that you cannot see
in a lab, for example, vectors or the path of a body

•
•

Offers both high school
and college level ancillary
support, with supplementary exercises, and activities for easy lesson planning and grading
Widely adopted by major
textbooks
Complements textbook
problems
Excellent in-class demonstrations
The Interactive Physics
Homework Edition allows
students to work at home
and exchange assignments electronically with
teachers and other students

REAL LIFE APPLICATION
Design Simulation Technologies also develops Working
Model for professional scientists and engineers. Check out
www.workingmodel.com and
see the same, professional
motion simulation technology
your students learn with Interactive Physics!

CORRELATED WITH NATIONAL EDUCATION
STANDARDS
Your students master science objectives by creating simulations in essential physics topics, including:
1-D motion

Magnetics

2-D motion

Momentum

Collisions

Newton’s Law

Conservation Laws

Oscillations

Doppler effects

Particle Dynamics

Electrostatics

Planar Motion

Equilibrium

Projectiles

Evaporation

Pulley Systems

Frequency

Rockets

Friction

Rotational Dynamics

Gears

Sound Intensities

Gravitation

Statics

Kinematics

Waves

Kinetic Theory of Gas

Trig Functions

Machines

Work and Energy

SYSTEM REQUIREMENTS
Windows Systems
• Microsoft Windows 95/98/ME/2000/XP/Vista/Windows 7
• 1 GB RAM minimum
Design Simulation Technologies
43311 Joy Road, #237
• 60 MB disk space
Canton, MI 48187
• CD-ROM drive
USA
www.design-simulation.com
• Sounds card for sound experisales@design-simulation.com
ments

Help your students make the right moves toward their FUTURE!
www.interactivephysics.com

Welcome to Interactive Physics
Interactive Physics is the result of a 15-year collaborative effort between physics instructors and software engineers. It is correlated with
National Education Curriculum Standards and it teaches your students the same motion tools used by professional scientists and engineers.
We are confident that Interactive Physics is a valuable tool for your classroom and laboratory.
To begin, install Interactive Physics and go through each step of the demonstration described below.

Step

Related Physics Concepts

1. Creating a falling block
2. Adding a velocity vector
3. Making a pendulum
4. Graphing the pendulum’s motion
5. Changing gravity
6. Adding air resistance
7. Adding a spring
8. Controlling the spring constant
9. Collisions with a circle
10. Attaching a picture to an object
11. Adding sound
12. Adding a curved slot joint
13. Adding a force
14. Running demo files

Mass; freely falling objects; laws of motion; linear kinematics
Vector and scalar quantities; vector components; unit vector
Oscillatory motion; frequency and amplitude; rotational kinematics; centripetal force
Graphs and measurements; motion diagrams
Law of gravity; Newton’s second law
Air resistance; non-conservative forces
Spring oscillation; conservative forces; conservation of energy; kinetic and potential energy
Spring constant; natural spring length; equilibrium spring length
Collision; elasticity; frictional forces; impulse and momentum
Attaching pictures makes physics experiments realistic and fun
Sound waves; speed of sound; Doppler effect; sound frequency and intensity
Roller coaster physics; motion in two dimensions; conservation of energy and momentum
Concept of force; Newton’s first law; work and energy
Interactive Physics allows you to explore other essential physics topics, including:
electrostatics, evaporation and condensation, gears, kinetic theory of gas, machines,
magnetism, particle dynamics, projectiles and rockets, pulleys, rotational dynamics, static
equilibrium, superposition of waves, and many more.
Correlated with National and State Standards and Objectives, new interactive experiments
explore speed, distance, time, acceleration, force, weight, mass, gravity, and air resistance

15. Curriculum workbook

Installing Interactive Physics
Windows users:
1. Insert the Interactive Physics CD into the CD-Rom drive and
follow the installation instructions
2. When prompted for a serial number, enter “DEMO” or enter
your licensed serial number
3. When the “Choose Folder” window appears, click [OK].
4. For a step-by-step introductory tutorial, turn to the next page.

Mac users:
1. Insert the Interactive Physics CD into the CD-Rom drive.
Double-click on the InteractivePhysics CD-icon
2. Double-click on the DoubleClickToInstall icon in the
interactivePhysics window. Follow the installation instructions
3. For a step-by-step introductory tutorial, turn to the next page.

http://www.interactivephysics.com
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Starting Interactive Physics

4 Graphing the Pendulum’s Motion

1. Ensure that Interactive Physics is installed on your computer.

1. To graph the pendulum’s motion, click on the rectangle. Under the Measure
menu, select Position, then select Rotation Graph.
. Note: Data can be displayed as a graph, bar chart,
2. To collect data, click
.
or number, and can be changed while running the experiment. Click
3. The graph shows the pendulum’s amplitude and frequency. To make the graph
larger, click on the graph and drag its lower right-hand corner to the right.

2. From the Windows
menu, click on Programs and then InteractivePhysics
and then InteractivePhysics. This opens a new experiment.

1 Creating a Falling Block
1. The first simulation is Newton’s first experiment, dropping a block.
2. To draw a rectangle, click on the Rectangle tool, then click in the workspace and
draw a long thin rectangular block.
.
3. To run the experiment and see the block fall due to gravity, click
4. Click
to reset the experiment.

5 Changing Gravity
1. To change gravity, click on the World menu, select Gravity, slide the slider to the
top for the value 20 m/sec2, and click [OK].
2. Click
and observe that, in agreement with theoretical and experimental
.
predictions, the pendulum has a higher natural frequency. Click

2 Adding a Velocity Vector
1. To add a velocity vector, click on the rectangle.
2. From the Define menu, click on Vectors and then Velocity.
and observe that the vector changes magnitude as the block falls.
3. Click
4. Click
.
Optional: To add a numerical value to the velocity vector (or its components), click
on the Define menu, select Vector Display, and check the Value box.

3 Making a Pendulum
1. To make a pendulum, click on the Pin joint tool and then click on the upper lefthand corner of the rectangle.
2. Click
and observe that the vector changes magnitude and direction as the
.
pendulum moves. Click

6 Adding Air Resistance
1. Under the World menu, select Air Resistance, click on Low Speed, and accept
the default air resistance value of 0.3 kg/(m*s) by clicking [OK].
2. Click
and observe the exponentially decaying oscillations. Click
.
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7 Adding a Spring

9 Collisions with a Circle

1. To add a spring, click on the Spring tool. Click on the upper right-hand corner of
the block and stretch the spring up and to the right.
and observe the pendulum's higher natural frequency and new
2. Click
equilibrium position. Click
.

1. To create a circle, click on the Circle tool, then click in the workspace and draw a
to zoom to extents.)
circle. (If your rectangle is high on the screen, click
to start the experiment and observe that the circle bounces and rolls
2. Click
on top of the rectangle. Automatic collision and contact is a very useful feature in
Interactive Physics (even the elastic and frictional properties of objects may be
.
varied). Click

8 Controlling the Spring Constant
1. To control the spring constant, click on the spring. Under the Define menu, select
New Control, then select Spring Constant.
2. The slider that controls the spring will appear in the left-hand side of the
workspace. To move the slider's location closer to the spring, click on its title and
drag it next to the spring.
3. To see the effect of varying the spring constant, click
and observe that the
pendulum angle is a function of the spring-constant (move the slider up and down
.
while the experiment is running). Click

10 Attaching a Picture to an Object
1. To find the spaceman picture on Windows, select
then InteractivePhysics, then the IPIntroduction folder.

menu, then Programs,

Note: Mac users browse to Interactive Physics, then Picture Library, then People.
2. Double-click on the bitmap file “Spaceman.bmp.” This should open the bitmap in
a program such as Paint.
3. In Paint, select the Edit menu and then choose Select All.
Next, select the Edit menu again and then choose Copy.
4. Go back to Interactive Physics and select its Edit menu and then choose Paste.
5. To attach the spaceman bitmap to the circle, click on the spaceman, then hold
down [Shift] while you click on the circle.
6. Select the Object menu and then Attach Picture. Notice that the circle object has
disappeared and has been replaced by the spaceman image.
7. Click
to run the experiment. Click
.
Note: Interactive Physics was designed to be easy-to-use. In this exercise, the
only time you need to touch the keyboard is to hold down the [Shift] key.
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11 Adding Sound (Windows only)

14 Running Demo Files

1. Click on the spaceman, select the Measure menu and choose Hear the Collision.
2. Click
to start the experiment and hear the sound when the spaceman
.
contacts the block. Click

Windows users:
1. Under the Script menu, click on "Run All Demo Files."
2. Sit back and enjoy a series of demos on a variety of physics topics.
3. To quit, select the File menu and choose Exit.
Mac Users:
1. Browse to the For Demo Users folder installed with Interactive Physics.
2. Double-click on each of the files, then click Run.
3. To quit, select the File menu and choose Quit.

12 Adding a Curved Slot Joint
1. To add a Curved Slot Joint, click on the Curved Slot joint tool.
2. Click on the spaceman and then click on a couple of other places to the right of
the spaceman, and then double-click to complete the slot (see figure below).
to start the experiment and observe that the spaceman slides down
3. Click
the curved slot. Click
.

15 Curriculum Workbook
Supplementary workbooks with Interactive Physics exercises of varying difficulty
are available with purchase. To try the instructional curriculum:
, then Programs, then
Windows users: Go to the Windows
InteractivePhysics, then click on StartCurriculum.html, then choose Demo Users.
Mac users: Open the installation CD and double-click on each of the files in the
IPCurriculum folder. Follow the on-screen directions.
Note: The Demo Edition can open only Demo files. The Full Edition must be
purchased to open the curriculum and additional 150+ physics experiments.

13 Adding a Force
1. To add thrust to the spaceman to overcome air resistance, click on the Force
tool, then click on the spaceman, then move the mouse to the left and click again.
2. Click
to start the experiment and observe that the spaceman overcomes
.
air resistance and moves more quickly along the curved slot. Click

New interactive experiments explore concepts in Energy,
Temperature, Heat Transfer, Waves, and Sound
Plus experiments in speed, distance, time, acceleration, force, weight, mass,
gravity, and air resistance
New curriculum workbook correlated with National and State Educational
Standards and Objectives
Full-color teacher edition and black-line master student edition

Last updated 7/15/2005 by Paul Mitiguy and Michael Woo
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Interactive Physics
The Americas Price List – February 1, 2009
http://www.interactivephysics.com
Interactive Physics™
Description
Single User (node-locked)***

UPGRADE+ from IP5.0, IP2000, 2004++, or higher (Windows)

http://www.interactivephysics.com
Item No.

Price

# of

# of

($)

CDS
1

IP01NL

249

Manuals

# of
TEW*

# of
SCB**

1

1

0

IP01NLUp

Item No.

Price

# of

# of

($)

CDS
1

119

Manuals

# of
TEW*

# of
SCB**

0

1

0

Additional Single User***

IP01

100

1

0

0

0

IP01Up

50

1

0

0

0

10 User

IP10

995

1

1

1

1:10

IP10UP

398

1

0

1

1:10

20 User

IP20

1,495

1

1

1

1:20

IP20Up

598

1

0

1

1:20

30 User

IP30

1,995

1

1

1

1:30

IP30UP

798

1

0

1

1:30

50 User

IP50

2,995

1

2

2

1:50

IP50Up

1,198

1

0

2

1:50

75 User

IP75

4,245

1

2

2

1:75

IP75Up

1,698

1

0

2

1:75

100 User

IP100

5,495

1

3

3

1:100

IP100Up

2,198

1

0

3

1:100

200 User
300 User

IP200
IP300

7,995
10,495

1
1

4
5

4
5

1:200
1:300

IP200Up
IP300UP

3,198
4,198

1
1

0
0

4
5

1:200
1:300

IPCustom

Call

Call

Call

Call

Call

Call

Call

Call

Call

Custom User
9***

IpCustomUp

Call

Requires 10+ user license of current Interactive Physics. Allows School to make an
additional copy of SCB for each home license/CD purchased

IPHW

500

10

0

0

0

Workbook Homework Bundle

IPHWWBK

850

10

0

0

10

Requires 10+ user license of current Interactive Physics.

Student Curriculum Black-line
Master

IPSCB

195

0

0

0

1:10

Requires 10+ user license of current Interactve Physics

Student Curriculum Workbook9
IP Workbook College

IPSCW
IPSCHW

495

0

0

0

10

Requires current Interactive Physics License

35

0

0

0

0

By Cindy Schwarz / John Ertel; Calculus-based physics

Extra Manual

IPUSR

50

0

1

0

0

Requires current Interactive Physics license

Spanish
p
Manual

IPUSRSP

50

0

1

0

0

Training

IPACL

Call

Call

Call

Call

Ancillary Curriculum License for special development, training, etc.

1

1

0

0

For textbook publishers who bundle with 1000+ Textbook Editions

Homework
9

Developer10

Call

Call
2,500

Requires
q
current Interactive Physics
y
license

+

Interactive Physics upgrades will be accepted with corresponding valid IP5.0 or IP2000 serial number (Windows)

++

Upgrades to IP2005 from IP2004 are $50 + 50% of the listed upgrade price.

Interactive Physics upgrades ship with installation instructions and an introductory tutorial. Information about new features is contained in the CD.

Mac Users: Macintosh customers should try a demo before purchasing to ensure OS compatibility (e.g., Mac OS X Tiger may not install classic mode).
Interactive Physics version 5.0 is the current version for the Macintosh and runs under classic mode in Mac OS X, not under native Mac OS X.
To run Interactive Physics under classic mode on Mac OSX Jaguar or later, it is necessary to log on as an administrator.
*TEW = Teacher Edition Workbook – part of a full purchase or upgrade product (not sold separately)
**SCB = Student Curriculum Black-line Master: one black line master is shipped with the right to reproduce copies for the exact number of licenses purchased
*** Single users and Homework users need to provide a machine ID to obtain a node-locked machine-specific installation serial number (not required for Network Licenses).
1 A copy of the school's purchase order and/or purchasing information must accompany all orders from the school ordering the software.
2 Orders to US and Canada: American Express, Visa, MasterCard, Discover, checks, purchase orders accepted.
3 International orders: American Express, Visa, MasterCard and bank wire transfers accepted. For orders shipped to destinations outside of the continental United States
that are less than $1,000 shipping charges will be added to the order or a UPS, DHL, or Fedex account must be provided.
4 Sales tax is added unless a Federal Excise Exempt Certificate or Local Sales Use Tax Exempt Certificate is submitted with the purchase order.
5 When possible, orders are shipped within 48 hours.
6 All sales are final. If you are tentative about a purchase, ask for a demonstration copy.
7 To trade up from x users to y users (with or without an upgrade), use the following price calculation formula:
Trade-up price = (new y user price – new x user price) + x upgrade price (if applicable)
Example: 10 user upgrade trade-up to a new 30 user: ($1995 - $995) + $398 = $1398
8 Resellers are required to fax the school purchase order when placing an order.
9 Homework/Student Editions do not include manuals or technical support and are only for student use on student-owned computers (not for school computers).
Homework/Student Edition licenses are valid for one year and are limited to 50 bodies, 15 constraints, and 15 output meters.
10 Textbook Editions are licensed with a Developer version and are able to play simulations created by a developer (for publishers etc.)
11 Technical support is provided by your software vendor for the first four months of new or upgrade purchases.
12 Multi-user licenses are networkable.
13 Prices and terms are subject to change without notice.

